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Case Studies Appendix

This appendix provides structured practice using Project 2013 to help you solidify what you’ve learned 
throughout this book. We’ve organized the material by chapter and recommend that you do each set of 
exercises immediately after reading the related chapter.

You’ll find the following types of practice:

hh Hands-on exercise project: The Relocation Project
Test yourself by creating a schedule with Project 2013 in the Relocation Project exercises. You’ll be 
the project manager responsible for an office move of about 100 co-workers to a new location that you 
have yet to find.

Hands on for Chapter 9 includes additional exercises to shorten the duration of an Intranet Project.

The solution Project 2013 files to the Relocation Project exercises are part of this download at www.
jrosspub.com. Click the link WAV Download Resource Center to enter the download site.

hh Troubleshooting
These exercises will help you understand some of the pitfalls people commonly encounter using Project 
2013. All of the exercises are based on situations we’ve encountered over many years of reviewing 
and certifying Project schedules. The typical troubleshooting situation is one in which the schedule 
stubbornly refuses to do what the creator expects. The exercises can help you prepare for providing 
technical support to other Project 2013 users.

hh Case studies
The case studies are provided to give you additional practice in the subject matter of Dynamic 
Scheduling. They have been updated with material from Microsoft® Project 2013 and moved to the 
appendix for easy access and a central point of referral. The files have been updated to reflect current 
dates and the new look of Project 2013.1

Enjoy!

1	 The names in the case studies are fictitious. Any resemblance to names of existing people or organizations is purely coincidental.
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Objective: 
Prepare the project file to facilitate the beginning of a project plan

Project 2013 Objectives: 
1.	 Create a new Project 2013 file
2.	 Set the Project Properties
3.	 Set the File Options
4.	 Set the Project Calendar

Exercise Deliverables: 
Project 2013 file finished to continue with the next chapter exercise

Hands on Exercise Project Information:

Relocation Project — Scope Statement

You are put in charge of relocating your office. You have to find a new location 
and organize the move. The following is the scope statement for the project, 
signed by your CEO.

Scope Statement for the Relocation Project of DEVOM, Inc.
Project accounting code: MOVE001

The Business Need
DEVOM, Inc. is growing and needs larger facilities to accommodate the 
expanding workforce.

The Project Objectives

hh To be moved and operational in the new location by November 1, 2014
hh To stay within the available budget of $150,000
hh To have an 80% satisfaction rate from the personnel for the new work 

environment

The Project Deliverables and Requirements

hh A project plan (including WBS, Network Diagram, Gantt Chart, budget, 
resource list, and assignments)

hh A new rented or leased location that has a maximum capacity of 150 work 
spaces and should:
`` Be accessible to disabled people
`` Have parking facilities for at least 150 cars
`` Have modern work cubicles and an open workspace

hh Contracts with the landlord, the general contractor, and the moving 
company

hh The physical move of people and equipment

Chapter 2: Getting Started with Project 2013
Chapter 
Objectives
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The Project Constraints

hh The work on the project is to start no earlier than August 4, 2014 
hh The personnel have to be asked for input as to the location and facilities 

needed
hh The disruption to the normal operations of DEVOM, Inc. should be 

minimized and may not exceed a loss of 200 person days caused by the 
project

hh Clients will have to be able to contact DEVOM, Inc at any time by phone, 
fax and e-mail

hh The purchase of new materials and equipment shall be budgeted and 
approved separately

hh The new location will be within the boundaries of the city and its suburbs
hh The need for expansion is so urgent that the project has priority over normal 

operations
hh Any changes to the project objectives will require the approval of the CEO

The Project Assumptions

hh The market will continue to grow at the same rate
hh The current furniture can be reused
hh The current workstations can be reused
hh The current LAN and servers will be replaced

Date:   …….......................
Your signature:..........................................................	
Project Manager, Relocation Project	 CEO, DEVOM, Inc.

You decide to make a project plan and to put the schedule in Project 2013, so 
fill in the date and sign the scope statement above, to take charge of this project.

1.	 Create a new Project 2013 file.

2.	 Set the start date for the project to August 4, 2014.

On the File tab, in the Backstage View, click on Info.

Under Project Information, place the mouse over the Start Date box, click 
the down-arrow and set the Start Date.

3.	 Click on Project Information, Advanced Properties, and on the 
Summary tab enter the title of the project: Relocation DEVOM, Inc.

4.	 You are the responsible project manager; enter your own name under 
Manager.

5.	 Enter DEVOM, Inc. under Company.

Relocation Project 
— Create a new 
Project 2013 file 
and set the project 
properties
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6.	 Formulate one sentence that captures the essence of the relocation project 
and enter it in the field Comments.

7.	 Click OK, to close the dialog.

8.	 Save the file as Relocation.mpp.

Continue to work in the file Relocation.mpp and enter only the following. 

1.	 On the File tab, in the Backstage View, on Options:

Project 
Options

Set to

General Date Format: Jan 28 ´09 
User name: <your name>

Schedule Hours per day:  8

Hours per week:  40

Days per month:  20

Select the Show scheduling messages checkbox

Show assignment units as a: Decimal2

New tasks created: Manually Scheduled	

Duration is entered in: Days

Work is entered in: Hours
Default task type: Fixed Duration
Unselect the New tasks are effort driven checkbox
Select the Tasks will always honor their constraint dates 
checkbox
Calculate project after each edit: Select On

Advanced Select the Automatically add new resources and tasks checkbox

Click OK, to close the dialog.

Continue to work with your file Relocation.mpp and enter the following:

1.	 On the Project tab, Properties group, click on Change Working Time. 
`` Check that the working hours on the Standard (Project Calendar) 

are:  
8:00AM to 12:00PM and
1:00PM to 5:00PM

`` Enter the following national holidays for the months September, 
October, and November in the Standard (Project Calendar). Since this 

2	 In this project we will use individual and group resources and will therefore use decimals rather than 
percentages.

Relocation Project 
— Set the File 
Options

Relocation Project 
— Set the Project 
Calendar
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project takes place in the US, enter the following national holidays of 
the United States:

▶▶ Labor Day, September 1, 2014
▶▶ Columbus Day, October 13, 2014
▶▶ Veterans Day, November 11, 2014

2.	 Now that you’ve finished with the deliverables, you can compare your file 
with the solution file 02 Getting Started.mpp.

1.	 Open the file 02 Wrong Hours per Day.mpp 

2.	 Correct the Hours per day, setting the file to 8 hours per day without affecting 
the durations. On the File tab, in Backstage view, click on Options, and on 
the Schedule tab change the hours per day. 

Troubleshooting
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Objective:
Capture the work breakdown structure (WBS) with the help of the software 
to the level of detail tasks, which are the basis for the next planning processes.

Project 2013 Objectives:
1.	 Enter the WBS
2.	 Indent Tasks
3.	 Set the Task Mode

Exercise Deliverables: 
Project WBS in Project 2013

Continue to work with your file Relocation.mpp or open the file 03 Entering 
Tasks.mpp.

1.	 On the File tab, in the Backstage View, on Options, click on Schedule.  
Check the following:
`` The Default task type is set to Fixed Duration.
`` The option  New tasks are effort-driven is cleared.

2.	 On the Gantt Chart view, on the Format tab, in the Show/Hide group, 
verify that the option Project Summary Task is checked. 

3.	 Enter the following WBS into Project 2013 as shown in the next table.3

ID Task Name ID Task Name
1. REQUIREMENTS 20. Install electric wiring
2. Research staff requirements 21. Paint
3. Summarize requirements 22. Drying of paint4 
4. Requirement document completed 23. Install cabinetry
5. LOCATION 24. Install LAN
6. Select the realtor 25. Lay carpet
7. Visit the sites 26. Facility remodeled
8. Evaluate the sites 27. MOVE
9. Meet to select the location 28 Select mover
10. Legal review 29. Pack
11. Location selected 30. Move
12. REMODELING CONTRACT 31. Unpack

3	 Capital letters are used here to indicate which tasks will eventually become summary tasks. Project 2013 
displays the summary tasks in bold type to make them stand out by default. This will happen when you 
indent tasks.

4	 You might wonder if drying of paint should be entered as a task, because it happens by itself. We use it here 
only to illustrate the use of an elapsed duration. Alternatively, you could enter it as lag on the dependency 
between paint and its successor.

Chapter 3: Entering Tasks
Chapter 
Objectives

Relocation Project 
— Entering the 
WBS
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ID Task Name ID Task Name
13. Select the contractor 32. New location opened
14. Meet to discuss contract 33. POST MOVE REVIEW
15. Revise the schedule 34. Inspect building and identify open 

issues
16. Negotiate the contract 35. Interview employees and identify 

open issues
17. Contractor contracted 36. Negotiate completion of open issues
18. REMODELED LOCATION 37. Complete contractor payments
19. Relocate walls 38. Complete lessons learned

1.	 Select all the detail tasks from the list above (tasks not in uppercase letters).

2.	 Keep the selection and on the Task tab,  Schedule group, click on Indent 
task. Now the detail tasks are indented and the summary tasks are displayed 
in bold type to make them stand out. 

 Continue to work with your file Relocation.mpp.

1.	 Select the last six tasks, including the POST MOVE REVIEW summary 
task, and on the Task tab, Tasks group, click on Manually Schedule. 

2.	 Save your Relocation.mpp file for future exercises.

3.	 Compare your file with the solution file 04 Entering Estimates.mpp. 

Norm was feeling proud but tense as he drove home from work: he’d just 
received his first assignment as a project manager. Norm felt the assignment was 
recognition of his outstanding technical expertise, and he was eager to get to 
work.

In the evening, Norm started to break down the work. This project was different 
from other projects he’d worked on, and though he had some idea about what 
deliverables and activities would be needed, he was worried about whether he’d 
be able to identify all of them. He decided that as a leader, he wanted to stay ahead 
of his team and create a WBS so his team would be impressed. That night he 
worked very hard and lost some sleep over his WBS. The next day, he introduced 
it to the team with, “Here is what we are going to do...” His team was quick to 
point out that he’d forgotten to incorporate the logistics, documentation, and 
training components in his WBS.

Questions:

1.	 What do you think about Norm’s decision to create a WBS by himself?

2.	 What led him to do it by himself?

Relocation Project 
— Indent the tasks

Relocation Project 
– Set Task Mode

Case Study: “My 
First Time …”
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3.	 Would you have done it by yourself if you were in his shoes? Why or why 
not?

Open the file 03 My Outline.mpp.

Explain why the outline does not function as an outline with summary tasks that 
can be collapsed and expanded.

Troubleshooting
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Objective:
Assign the duration estimates and/or work estimates for each task within 
the WBS.

Project 2013 Objectives:
1.	 Enter Work Estimates. 
2.	 Enter Duration Estimates.
3.	 Set Task Type.
4.	 Set Effort Driven.

Exercise Deliverables: 
Project Tasks with Work and Duration estimates in Project 2013

Continue to work with your file Relocation.mpp or open the file 04 Entering 
Estimates.mpp.

1.	 Insert the fields Type, Effort Driven, Duration, and Work in the Gantt 
table in the order they appear in the column headings of the next table.

2.	 On the File tab, in the Backstage view, on Options, click on Schedule and 
verify that the time unit for Work is entered in is set to Hours.

3.	 Enter the data from the table below into the Relocation project file. The tasks 
with a zero duration will become milestones. Where no data is provided 
you don’t enter anything; Project 2013 will fill in the default duration of 1 
day? and the default work of 0 hrs. Leave these as they are; you cannot blank 
them out.

ID Task Name Type
Effort 
Driven Duration Work

1. REQUIREMENTS Fixed Duration5 No

2. Research staff 
requirements

Fixed Work Yes 16h

3. Summarize requirements Fixed Work Yes 16h

4. Requirement document 
completed

Fixed Duration No 0

5. LOCATION Fixed Duration No

6. Select the realtor Fixed Duration No 4 d

7. Visit the sites Fixed Duration No 1 d

5	 Notice that you cannot change the Type of a summary task; it is set by Project 2013 to Fixed Duration. 
No Durations or Work numbers are provided for summary tasks because these are calculated by Project 
2013 when the summary tasks are in Auto Schedule mode. In Manually Schedule mode you can change 
the summary task duration to create estimates.

Chapter 4: Entering Estimates
Chapter 
Objectives

Relocation Project 
— Entering 
Estimates and 
Task attributes
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ID Task Name Type
Effort 
Driven Duration Work

8. Evaluate the sites Fixed Duration No 1 d

9. Meet to select the location Fixed Duration No 1 d

10. Legal review Fixed Duration No 0.5 d

11. Location selected Fixed Duration No 0 d

12. REMODELING 
CONTRACT

Fixed Duration No

13. Select the contractor Fixed Duration No 2 d

14. Meet to discuss contract Fixed Duration No 1 d

15. Revise the schedule Fixed Duration No 1 d

16. Negotiate the contract Fixed Duration No 1 d

17. Contractor contracted Fixed Duration No 0 d

18. REMODELED 
LOCATION

Fixed Duration No

19. Relocate walls Fixed Work Yes 800h

20. Install electric wiring Fixed Work Yes 200h

21. Paint Fixed Work Yes 64h

22. Drying of paint Fixed Duration No 4ed6

23. Install cabinetry Fixed Work Yes 320h

24. Install LAN Fixed Work Yes 480h

25. Lay carpet Fixed Work Yes 480h

26. Facility remodeled Fixed Duration No 0 d

27. MOVE Fixed Duration No

28. Select mover Fixed Duration No 2 d

29. Pack Fixed Duration No 2 d

30. Move Fixed Work Yes 160h

31. Unpack Fixed Duration No 2 d

32. New location opened Fixed Duration No 0 d

33. POST MOVE 
REVIEW

Fixed Duration 3 months 
approx.

34. Inspect building and
identify open issues

Fixed Duration tbd

6	 Notice the “e” in “4ed”; this is an elapsed duration that continues through the night and weekend.
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ID Task Name Type
Effort 
Driven Duration Work

35. Interview employees and
identify open issues

Fixed Duration tbd

36. Negotiate completion of
open issues

Fixed Duration tbd

37. Complete contractor
payments

Fixed Duration open issues

38. Complete lessons learned Fixed Duration tbd

4.	 Save your Relocation.mpp file for future exercises. 

5.	 Compare your file with the solution file 05 Entering Dependencies.mpp.

Mildevices, Inc. is a manufacturer of military products. The company makes 
navigation and intelligence products. LCD screens and consoles are some of its 
major products. Mildevices has engineering and manufacturing staff. There is a 
project control office with 25 project management staff members, and this office 
reports directly to the Vice President of Operations. The project control staff 
supports the engineers in delivering the projects.

Upper management typically initiates a new project. One executive becomes 
the project sponsor and finds an engineer that she will appoint as the project 
manager. The project manager puts the budget together with his team, and the 
budget is submitted for approval by the executives.

Executives typically cut the budget proposed by the engineers, because they are 
concerned with the bottom line of the company. The engineers find that the cuts 
are applied arbitrarily and often feel they end up with impossibly tight budgets. 
As a consequence, they start to increase their estimates in order to end up with 
reasonable budgets. In subsequent projects, the executives react to this in turn 
by cutting the proposed budgets even more. The new cuts are done in a way 
that makes even less sense to the engineers. As a result, the project managers 
now jack up their estimates even further and hide their padding in the estimates 
wherever they can. At this stage, the openness and the mutual trust are gone 
between the executives and project managers.

One of the schedulers in the project office, Debbie, says this about these 
developments: “The numbers the engineers receive back from senior 
management are so ridiculously low that they just laugh at them.” Inevitably, she 
says, budget overruns take place.

Case Study 
— Escalated 
Estimates
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Questions:

1.	 In your opinion, is the estimating done in a professional manner at 
Mildevices?

2.	 What type of problem is this? Is it predominantly an organizational problem, 
a cultural problem, or a financial problem?

3.	 If a project manager asked you for advice, what would you recommend to 
break this escalating spiral?

4.	 If an executive asked you for advice, what would you recommend to break 
this escalating spiral?
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Objective:
Develop a network that represents a dynamic model of the project.

Project 2013 Objectives: 
1.	 Enter dependencies in a variety of ways to link tasks.

Exercise Deliverables:
Project network diagram in Project 2013.

Continue to work with your file Relocation.mpp or open the file 05 Entering 
Dependencies.mpp.

Enter the following dependencies using the Link button, on the Task tab, on 
Schedule group:

1.	 The tasks research staff requirements, summarize requirements, and requirements 
document completed are sequentially dependent upon each other.

2.	 The tasks of the deliverable LOCATION are all sequentially dependent 
upon each other.

3.	 The tasks of the deliverable REMODELING CONTRACT are all sequentially 
dependent upon each other. The dependency between select contractor and 
meet to discuss contract has a lag of five days; it allows five days to get the 
participants together to meet.

4.	 The tasks relocate walls through install cabinetry of the deliverable 
REMODELED LOCATION are sequentially dependent upon each other.

5.	 The tasks of the deliverable MOVE are all sequentially dependent upon 
each other.

6.	 Enter the following dependencies by holding down the Control key and 
clincking to select the tasks and using the Link the Selected Task tool 
(Task tab, Schedule group):

7.	 In the deliverable REMODELED LOCATION the tasks install cabinetry and 
install LAN can take place concurrently after the paint dries. Drying of paint 
is the predecessor for both tasks.

8.	 After the tasks install cabinetry and install LAN are finished, the carpet can 
be put in place. Lay carpet is the successor for both tasks.

9.	 After the carpet is laid (lay carpet), the milestone facility remodeled is 
accomplished.

Chapter 5: Entering Dependencies
Chapter 
Objectives

Relocation Project 
— Entering 
Dependencies
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10.	 You forgot to set the dependencies between the deliverables (phases). 
Stay in the Gantt Chart or switch to the Network Diagram to enter these 
dependencies:

`` The task evaluate the sites can start after summarize requirements is 
finished.

`` The task select the contractor can start after the milestone location selected 
is accomplished plus 0.5 days, this way the task will start the first hour 
of the next working day.

`` The task select mover can start after location selected, plus 0.5 days, this 
way this task will start the first half hour of the next working day.

`` The task relocate walls can start after the milestone contractor contracted.
`` The task pack can start after the milestone facility remodeled.

11.	 Turn on the Task Path to analyze the Driving Predecessors. 

Answer the following questions about the dependencies in the Relocation 
Project:

1.	 Using the Task Path feature, what drives the task Relocate Walls?

2.	 How long is this project initially estimated to run? 

3.	 Looking at the Network Diagram, is there a distinctive critical path (the red 
boxes)? 

4.	 Are there any dependencies on summary tasks? 

5.	 Although all of the summary tasks show row totals, the totals are calculated 
differently depending on the nature of the fields. How are the totals from 
the detail tasks reflected in the summary tasks for the fields Durations, 
Work and Cost?

6.	 If you are not managing resources with Project 2013, at this point do you 
have a valid schedule? 

7.	 Save your Relocation.mpp file for future exercises.  

8.	 Compare your file with the solution file 06 Entering Constraints and 
Deadlines.mpp. 

CoalPower power station has approached you to do a 3-day introductory 
workshop on Project 2013. CoalPower is a first-time client and it seems this 
3-day contract will be its only need for training and consulting for a while, even 
though the organization is large and has multiple plants. The key players at 
CoalPower are:

hh Andy is the plant manager. You find out that you and he share a similar 
cultural heritage, and that this provides an easy basis for conversation 

Case Study: 
CoalPower
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with him. Andy sits in on the first part of the on-site workshop you’re 
conducting. He is only interested in the big picture: what can Project 2013 
do for the organization. Andy is concerned about the frequent delays in the 
engineering projects, as you found out when you talked one-on-one during 
a lunch break.

hh Norm manages the engineers who manage repair, maintenance and 
construction projects in the power station. They also design the 
modifications that are needed. You have had difficulties negotiating with 
Norm. He told you, only after you had closed your consulting contract, that 
you would have to travel an extra 250 miles to get to the project site.

hh Dave and Harry manage major maintenance projects like the replacement 
of the $2M turbine condensers. Replacing these condensers will stop 
operations in the entire plant. They have been planning their projects mostly 
off the tops of their heads. Norm is getting increasingly anxious about this 
and has told them, “If you get sick, nobody knows what to do or how to do 
it. I need to see a detailed plan of your projects!”

hh Art is the technical drawing expert. He designs most of the small 
modifications and creates the technical drawings. Art is overworked and 
has, at any given time, 50 projects on his plate. Norm often criticizes Art for 
not delivering drawings when Norm wants them.

Questions

Dave and Harry are struggling with the whole concept of scheduling and what 
benefits it will provide to them:

1.	 Do you expect them to be motivated to use the tool? Why?

2.	 How will they benefit from scheduling their projects with Project 2013?

3.	 What do you think of Norm’s approach of forcing them to schedule their 
projects?

4.	 How important are dependencies in their schedule?

5.	 Art approaches you during one of the breaks to talk one-on-one:
a.	 What is his main concern in scheduling his projects?
b.	 How should he model his many projects in Project 2013? Address in 

particular whether he should use dependencies in his schedule:
▶▶ Between the tasks within one project 
▶▶ Between his projects

c.	 How will Art benefit from modeling his projects in Project 2013?



16

Dynamic Scheduling® with Microsoft® Project 2013

Objective:
Include the constraints and deadlines of the dynamic model that represents 
the project.

Project 2013 Objectives: 
1.	 Enter Constraints.
2.	 Enter Deadlines.
3.	 Enter Task Calendars.

Exercise Deliverables:
Project network diagram with deadlines and constraints in  Project 2013.

Continue to work with your file Relocation.mpp or open the file 
06 Entering Constraints and Deadlines.mpp.

1.	 Set deadlines on the following milestones:

ID Milestone Deadline Date
11 Location selected August 15, 2014

17 Contractor contracted August 29, 2014

26 Facility remodeled October 24, 2014

32 New location opened October 31, 2014

2.	 The CEO, Mr. Salin, is out of the country until August 25, 2014. Also the task 
pack should be scheduled As Late As Possible, otherwise the equipment may 
be packed days before the actual move takes place over the weekend. You 
want the employees to be packed as late as possible on the Friday before the 
weekend. Enter the following constraints:

ID Task Constraint
9 Meet to select the location Start No Earlier Than August 25, 2014

29 Pack As Late As Possible

1.	 You realize that due to the project requirement that disruption to normal 
company operations be minimal, the move will have to take place over the 
weekend. For the task Move, set all the weekdays to nonworking days and 
the weekend days to working days, so the move will take place on a weekend.

2.	 Use the Change Working Time to create a new calendar called Weekends. 
Establish a working time of 8 hours per day for Saturday and Sunday.

3.	 Assign this new calendar to the task Move. 

4.	 Save your Relocation.mpp file for future exercises.

Chapter 6: Entering Deadlines, Constraints, and Task Calendars
Chapter 
Objectives

Relocation Project 
— Entering 
Constraints and 
Deadlines

Relocation Project 
— Task Calendars
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5.	 Compare your file with the solution file 07 Entering Resources.mpp. 
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 Objective:
List all resources that will be involved in the execution of the project tasks.

Project 2013 Objectives: 
1.	 Enter Resources and their details.
2.	 Enter Budget Resources.

Exercise Deliverables:
Resource sheet with all resources and their details in  Project 2013.

Continue to work with your file Relocation.mpp or open the file 07 Entering 
Resources.mpp.

This table shows the resources needed for the relocation project. Notice that 
there are generic resources in the list, like movers. You found their rates by 
telephoning around. There is no Cost/Use for these resources. 7

Resource 
Name Type

Material 
Label Position Function

Max. 
Units

Std. 
Rate

Accrue  
at

you7 Work project 
manager

manager 1 $75/h Prorated

Nelson Salin Work CEO manager 1 $150/h Prorated

John Falgon Work employee 
representa-
tive

employee 1 $30/h Prorated

Nancy 
Hilcrest

Work planner employee 1 $35/h Prorated

Pierre Roach Work lawyer external 1 $75/h Prorated

the 
employees

Work employees employee 75 $25/h Prorated

the 
contractor

Work contractor external 50 $30/h End

the realtor Work realtor external 1 $35/h End

the movers Work movers external 40 $25/h End

the LAN 
consultants

Work LAN con-
sultants

external 20 $75/h End

Moving Van Cost End

Lunch for 
Team during 
Move

Cost Start

7	 Fill in your own name instead of “you”.

Chapter 7: Entering Resources
Chapter 
Objectives

Relocation Project 
— Entering 
Resources
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Resource 
Name Type

Material 
Label Position Function

Max. 
Units

Std. 
Rate

Accrue  
at

boxes Mate-
rial

Boxes material $2 Start

1.	 Customize the table for the Resource Sheet view as shown in the table above. 
The fields Position and Function are not standard fields in Project 2013. You 
can use the fields Text1 and Text2 and permanently rename them Position 
and Function respectively using the Custom Field feature, available in the 
Project tab, Properties group.

2.	 Enter the resources. Use the Fill Down feature for the columns Function 
and Accrue at.

3.	 Sort the list of resources with resource Name as the first sorting key. Select 
the option to permanently renumber the resources.

4.	 You’ve resisted pressure to work longer hours, and with the rest of the team 
will keep regular working hours.

5.	 Nancy Hilcrest will go on a 1-week holiday in the third full week of August 
2014. Create the exception for Nancy’s calendar with the Change Working 
Time feature.

6.	 You realize that the task Move needs to be executed during the weekend 
(you have already created a specific calendar and assigned it to the task in 
Chapter 6). But the resources Movers use the standard calendar, so they 
won’t be able to work on weekends and you are creating a conflict. To solve 
this, just assign the right calendar to the Movers. 

7.	 Save your Relocation.mpp file for future exercises.

8.	 Compare your file with the solution file 08 Entering Assignments.mpp. Make 
sure you select to compare the resource information as well by selecting the 
Resource Table named Entry.

1.	 Open the file 07 Budget Resources 1.mpp. 

2.	 In the Resource Sheet view add the resource Labor and make it a cost type 
resource.

3.	 Double-click on the Labor resource and on the General tab of the Resource 
Information dialog box, select the Budget box and click on OK.

4.	 Go to the Gantt Chart view and using the Assign Resources Dialog box, 
assign the Labor resource to the Project Summary Task. Note that if you 
try to assign the Labor resource to any other summary or detail task you will 
not be able to.

Relocation 
Project — Budget 
Resources
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5.	 Go to the Resource Usage view and insert the column Budget Cost.

6.	 Right-click on the right side of the screen and select Detail Styles. From the 
available fields show the Budget Cost field and click OK.

7.	 Using the Zoom slider, zoom in or out until the timescale is showing months 
on the middlescale. You can then enter the monthly budget into the proper 
months.

8.	 Enter a Labor budget of $30,000 for August, September, October, and 
November of 2014. You should be able to see the total budget of $120,000 
in the Budget Cost column (field).

9.	 If you don’t allocate cost to your resources you can set this up so that your 
Labor resource is a work type resource. How would you associate your labor 
resources to the Labor budget? Think about using a custom resource field 
for this purpose. For example in the Resource Sheet view you might choose 
to make the custom field Text3 a field that contains Budget Type. For all 
the work resources and the Labor Budget resources you would select Labor 
as the Budget Type. In the Resource Usage or Task Usage View you could 
group by Budget Type. This would yield a comparison of budget costs on 
Labor to actual costs on Labor.

10.	 Compare your file with the solution file 07 Budget Resources 2.mpp.

Create a new project file and try entering the resource Smith, Harry. Why does 
Project 2013 not allow you to do that? 

Troubleshooting
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Objective:
Assign resources to project tasks.

Project 2013 Objectives: 
1.	 Assign Resources.
2.	 Change Assignments.

Exercise Deliverables:
Resource-loaded project schedule in  Project 2013.

Continue to work with your file Relocation.mpp or open the file 08 Entering 
Assignments.mpp.

hh Enter the assignments as shown in the next table. First, add the fields Type, 
Effort Driven, Duration, and Work to the Gantt Chart view in such a way 
that the view matches the Task Fields column headings in the next table. 
Note that you cannot add the Assignment Fields shown in the table; you have 
to enter the assignment information in the Assign Resources dialog or in 
the Task Form.

hh Remember that Project 2013 uses the formula Duration * Units = Work and 
will calculate for each detail task the third value that is not provided in the 
next table.

hh Think about the easiest way to enter each assignment; decide whether you 
should use the Assign Resources dialog, the Task Form, or the Team 
Planner. The Task Form is best when you want to assign multiple resources 
with specific numbers for units and/or work.

hh Only the Fixed Work tasks are Effort Driven.

TASK FIELDS – Gantt Chart View

ASSIGNMENT 
FIELDS –  

Assign Resources 
Dialog Box

Task Name Type
Effort 
Driven Dur. Work

Resource 
Names Units

REQUIRE-
MENTS

Fixed 
Duration

No

research staff 
requirements

Fixed 
Work

Yes 16h You 0.5

summarize 
requirements

Fixed 
Work

Yes 16h Hilcrest 0.5

Chapter 8: Entering Assignments
Chapter 
Objectives

Relocation Project 
— Entering 
Assignments
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TASK FIELDS – Gantt Chart View

ASSIGNMENT 
FIELDS –  

Assign Resources 
Dialog Box

Task Name Type
Effort 
Driven Dur. Work

Resource 
Names Units

LOCATION Fixed 
Duration

No

select the realtor Fixed 
Duration

No 4 d You 0.5

visit the sites Fixed 
Duration

No 1 d Falgon 
Hilcrest 
the realtor 
You

1
1
1
1

evaluate the sites Fixed 
Duration

No 1 d Falgon 
Hilcrest 
the realtor 
You

1
1
0.5
1

meet to select the 
location

Fixed 
Duration

No 1 d Falgon 
Hilcrest 
Salin 
you

1
1
1
1

legal review Fixed 
Duration

No 0.5 d Roach 1

REMODELING 
CONTRACT

Fixed 
Duration

No

select the contractor Fixed 
Duration

No 2 d You 1

meet to discuss 
contract

Fixed 
Duration

No 1 d the contractor
Hilcrest 
You

1
1
1

revise the schedule Fixed 
Duration

No 1 d You 1

negotiate the 
contract

Fixed 
Duration

No 1 d You 1

REMODELED 
LOCATION

Fixed 
Duration

No

relocate walls Fixed 
Work

Yes 800h the contractor 10

install electric 
wiring

Fixed 
Work

Yes 200h the contractor 5
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TASK FIELDS – Gantt Chart View

ASSIGNMENT 
FIELDS –  

Assign Resources 
Dialog Box

Task Name Type
Effort 
Driven Dur. Work

Resource 
Names Units

paint Fixed 
Work

Yes 64h the contractor 4

drying of paint Fixed 
Duration

No 4 ed

install cabinetry Fixed 
Work

Yes 320h the contractor 8

install LAN Fixed 
Work

Yes 480h the LAN 
consultants

5

lay carpet Fixed 
Work

Yes 480h the contractor 6

MOVE Fixed 
Duration

No

select mover Fixed 
Duration

No 2 d You 1

pack Fixed 
Duration

No 2 d the employees 
boxes, Moving 
Van[$320]

35
400

move Fixed 
Work

Yes 160h the movers, 
Lunch [$210]

10

unpack Fixed 
Duration

No 2 d the employees 35

hh Save your Relocation.mpp file for future exercises. 

hh Compare your file with the solution file 09 Optimizing — Time 1.mpp. 
Notice that the project is missing its October 31st deadline. We will need to 
optimize the schedule in the next chapter.

Continue to work with your file Relocation.mpp or open the file 09 Optimizing 
— Time 1.mpp.

How should you go about making the following changes to the assignments? 
You may need to change the Type of the task first.

The task install LAN currently has a duration of 12 days, 5 consultants working 
on it and 60 days of work (or 480 hrs of effort).

Relocation Project 
— Changing 
Assignments
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1.	 You would like to know how long the task install LAN would take if there 
were 10 LAN consultants instead of 5 while keeping the work the same.
`` What task type do you need before you make this change? 
`` You should get a duration of 6 days. Keep this change.

2.	 You want to know how many consultants are needed if you want the task 
install LAN done in 3 days while keeping the work the same. 
`` What task type do you need before you make this change? 
`` You should find that 20 LAN consultants are needed. Keep this change.

3.	 You think you over-estimated the work in the install LAN task; you will 
need only 30 days (240 hours) of work instead of 60 days (480 hours) of 
work and you want to keep the duration to 3 days. 
`` What is the number of consultants needed now? 
`` What task type do you need before you make this change? 
`` You should find that 10 consultants are needed. Keep this change.

4.	 You want to keep the number of consultants to 10, but you want to change 
the duration from 3 to 12 days. 
`` How much work is now on the task? 
`` What task type do you need before you make this change? 
`` You should end up with 120 days or 960 hours of work. Keep this 

change.

5.	 You want to bring the number of consultants down to 5 while keeping the 
12-day duration. 
`` How much work is now on the task? 
`` What task type do you need before you make this change? 

This brings us back to where we were at the start of this exercise after exploring 
several scenarios.
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Objective:
Analyze the project and come up with proposals to optimize duration, costs 
and resources in order to fulfill the project objectives. 

Project 2013 Objectives: 
1.	 Understanding the Gantt Chart.
2.	 Shorten the Duration.
3.	 Lower the Cost.
4.	 Solve Over-allocation by assigning Available Resources.
5.	 Solve Over-allocation using Resource Leveling.

Exercise Deliverables:
Various project optimization proposals in Project 2013.

Open the file 09 Opt-Time1.mpp. 

1.	 Display the field Total Slack in the spreadsheet of the Gantt Chart.

2.	 Is the total slack expressed in calendar days, business days, or person days?

3.	 Why does the negative slack change from task 14 meet to discuss contract to 
task 15 revise the schedule? Hint: Task 14 meet to discuss contract has a lag of 
five days with its predecessor task 13 select the contractor, also Nancy is on 
holiday in the third full week in August..

4.	 Why does the negative slack change in the middle of task 21 paint and task 
24 install LAN? Hint: there is a task with an elapsed duration between them 
and the other task had an original slack of seven days.

5.	 Why does the negative slack change from task 26 facility remodeled to task 
30 move?  Hint: there is a deadline on task 26 and task 29 pack is scheduled 
As Late as Possible.

6.	 Why does the negative slack change from task 30 move to task 31 unpack? 

Hint: the movers only work on the weekend.

In this exercise, you’ll use the optimizing for time approach.

Open the file 09 Opt-Time1.mpp. 

Currently, the forecasted finish date is November 18, but your CEO insists that 
the office be moved by November 1.

1.	 Display the critical path in your schedule. Make sure you understand all 
the total slack numbers on each task (described in the previous exercise, 
Relocation Project—Understanding the Gantt Chart).

Chapter 9: Optimizing the Schedule
Chapter 
Objectives

Relocation Project 
— Understanding 
the Gantt Chart

Relocation Project 
— Shorten the 
Duration
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2.	 The objective of this exercise is to bring down the duration (time) of the 
project as much as is reasonably possible. Use the methods discussed in 
Chapter 9 to get ideas. Come up with your own ways to bring down the 
duration of the project as much as you can. Try them out and see how much 
time they save. Try to:
`` Make the project end date as early as possible, or
`` If you have a hard constraint on the project end milestone, make the 

Total Slack on the project end milestone new location opened positive 
and as large as possible.

3.	 Try your ideas out and see if they work. If you keep a change, make a note of 
it, in order to compare your measures against the solution.

In this exercise you’ll use the optimizing for time approach. To illustrate how 
a schedule can be optimized, we’ll explain a complete optimization that will 
cut the project duration down to almost half the original duration. A similar 
reduction can be achieved in many projects by applying all of the techniques 
discussed in chapter 9.

Open the file 09 Opt-Time2.mpp.

The current duration of the project is 74 days.

When the tasks are sorted by duration, you can see that the tasks drying of paint, 
install LAN, relocate walls, and lay carpet are some of the longest tasks. All of 
these tasks are critical and seem to be a good starting point for finding time in 
the schedule.

Enter the following changes to shorten the relocation project:

1.	 Create an overlap in the dependency on relocate walls, so that install electric 
wiring is done mostly in parallel with relocating the walls. Overlap relocate 
walls and install electric wiring with a Finish-to-Finish plus 1 day dependency. 
The electricians can start on a wall as soon as the carpenters have it up. What 
is the duration of the project now?

2.	 Remove the dependency between lay carpet and install cabinetry and 
remove the dependency between lay carpet and install LAN. Instead, make 
lay carpet dependent on drying of paint. Create new dependencies from 
install cabinetry and install LAN to facility remodeled to get rid of the loose 
ends in the network. You can lay carpet in parallel with installing cabinets and 
installing the LAN. What is the duration of the project now?

3.	 Notice that the critical path is fragmented at this point. We have to make 
sure that we continue making changes to critical tasks only. Make the 
necessary changes to the schedule in such a way that you see most of the 
critical path in the schedule again. Change the type of dependency between 

Relocation Project 
— Ideas for 
Shortening the 
Duration
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install electric wiring and paint to Finish-to-Finish plus 1 day. The painters 
can start on a wall as soon as the electricians finish it. What is the duration 
of the project now? Hint: Managing the thresholds can help to keep an eye 
on critical tasks that have a slack related to task calendars or lags.

4.	 Change the type of dependency between paint and drying of paint to Finish-
to-Finish plus 1 day. The paint starts drying as soon as the first wall is 
painted. What is the duration of the project now? 

5.	 Change the type of dependency between facility remodeled and pack to 
Finish-to-Finish. The packing should ideally be ready when the facility is 
ready. What is the duration of the project now? 

6.	 Remove the dependency between location selected and select the contractor, 
and make select the contractor dependent on evaluate the sites. Create a new 
dependency between location selected and meet to discuss contract. You can 
select the contractor when you have an idea which location will be chosen. 
What is the duration of the project now?

7.	 Get rid of the Start No Earlier Than constraint on task 9 meet to select the 
location and arrange for a conference call or internet meeting with the CEO, 
who is abroad. What is the duration of the project now? Notice that Task 
14 was split because of Nancy’s availability, since the duration of this task is 
changing you may want to consider to change the type of this task to fixed 
work.

8.	 Overlap summarize requirements and research staff requirements, Finish-to-
Finish plus 1 day. You can start summarizing as soon as you receive some 
completed questionnaires. What is the duration of the project now?  

9.	 Get rid of the 5 days lag on the dependency between task 13 select the 
contractor and task 14 meet to discuss contract. Make sure that you give 
advance notice of 5 days to the participants you expect at the meeting, so 
the 5-day time frame for calling the meeting is not needed anymore. What 
is the duration of the project now?

10.	 Change the task install LAN into a summary task by adding the following 
subtasks: install LAN cables (Auto Schedule Mode, 160h of Fixed Work, 
predecessor relocate walls), install LAN hardware (Auto Schedule Mode, 160h 
of Fixed Work, predecessor install LAN cables), and install LAN operating 
system (Auto Schedule Mode, 160h of Fixed Work, predecessor install LAN 
hardware, successor facility remodeled). 

Remove the dependencies between drying of paint and install LAN and 
between install LAN and facility remodeled. Keep the resource units at 5 
units for all subtasks; remove the LAN consultants from the summary task. 
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The result is a more refined schedule. What is the duration of the project 
now? 

11.	 Increase the resource units of the contractor for the task lay carpet from 6 to 
12. This decreases the duration of lay carpet to 5 days, which is now done 
entirely in parallel with install cabinetry. What is the duration of the project 
now?

12.	 You decide to ask the LAN consultants to work with 8 consultants instead of 
5. Change all assignments of the LAN consultants to 8 units on the subtasks 
of install LAN. This will reduce the duration of the subtasks to 2.5 days. 
What is the duration of the project now?

Please answer the following questions:

1.	 Check the duration of the project. We have reduced it from 74 to 36 days. 
This is less than half of the original duration and most changes are quite 
defensible. You have seen here an example of how you can find time in your 
project schedule if you create a dynamic model of your project in the first 
place. Could you apply similar methods to your own project schedule?

2.	 Were trade-offs made against the scope or quality of this project? What are 
they? Would you undo some proposed changes? Why?

3.	 If you arrived at a different final duration, find the differences between your 
file and the solution file 09 Opt-Time3.mpp. 

In this exercise, you’ll use the optimizing for time and cost approach. Open the 
file 09 Opt-TimeCost1.mpp.

Currently, the forecasted finish date is November 18 and a total cost of $138,210. 
The CEO insists that the office be moved by November 1 within the available 
budget of $120,000 plus a reserve of $30,000 totaling $150,000.

1.	 The objective now is to bring down the cost of the project while maintaining 
or decreasing the duration. Use the methods that were discussed in Chapter 
9 to get ideas. Come up with your own ways to bring down the cost of the 
project as far as you can. Try them out and see how much money they save.

2.	 Log each change and the total cost of the project after each change you keep.

3.	 Compare your results against the ideas that we will discuss in the next 
exercise.

Relocation Project 
— Lowering the 
Cost
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In this exercise you’ll use the optimizing for time and cost approach.

Open the file 09 Opt-TimeCost2.mpp.

The current duration of the project is 74 days.

You found some new resources:

Name Type Position Function
Max. 
Units

Std. 
Rate

Accrue 
at

Carpeteers Work Contractor external 20 $140/d End

Cablers Work Contractor external 5 $40/h End

Students Work Contractor external 5 $80/d End

You find a specialized carpet company Carpeteers that is willing to do the job on 
task 25 lay carpet. Create this new resource. Carpeteers estimates the work will 
take 30 person days (240 hours), and they will do it with 10 employees.

1.	 What is the current cost of the project?  
What is the current cost for the task lay carpet?  
What is the current duration of the project? 

2.	 Reassign the task to Carpeteers. 
What is the new forecasted cost for lay carpet?  
How much did we save on this task?

3.	 What is the new total cost of the project?

4.	 What is the new total duration of the project? 

5.	 What consequences does this change have for the scope and quality of the 
project? Why?

6.	 Would you keep the reassignment to Carpeteers?

Enter the following additional changes to lower the cost of the relocation 
project:

1.	 Inactivate the task revise the schedule; it is a nice-to-have task. Add a new 
dependency to keep the original logic. How much is the total cost now?

2.	 Inactivate the task select the realtor and hire the one you know. Is there a 
possible trade-off in doing this? How much is the total cost now? 

3.	 Inactivate the task select the contractor and hire the one you know. Add a new 
dependency to keep the original logic. Is there a possible trade-off in doing 
this? How much is the total cost now? 

4.	 Make the task install LAN a summary task by adding the following subtasks: 
install LAN cables (Auto Schedule Mode, 160h of Fixed Work, predecessor 

Relocation Project 
— Ideas for 
Lowering the Cost
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relocate walls), install LAN hardware (Auto Schedule Mode, 160h of Fixed 
Work, predecessor install LAN cables), and install LAN operating system 
(Auto Schedule Mode, 160h of Fixed Work, predecessor install LAN hardware, 
successor lay carpet). 
Keep the resource units at 5 units for all subtasks; remove the LAN 
consultants from the summary task. Remove the dependencies between 
drying of paint and install LAN as well as the dependency between install 
LAN and Lay Carpet. You ask the LAN consultants to use cheaper resources 
to do the cabling. They offer you specialized cablers, as shown in the table 
at the beginning of the question. Reassign the task install LAN cables to the 
cheaper resources cablers. How much is the total cost now?  

5.	 You ask the contractor to come up with sharper estimates to save cost. He 
offers to provide students who can help the carpenters relocate walls. He 
proposes to replace half of the contractor with students per the table. Are 
there possible trade-offs on time, scope, or quality? How much is the total 
cost now? 

6.	 In your search to reduce cost you decide that the 35 employees should pack 
all their stuff in 1 day instead of 2 days. Are there possible trade-offs on time, 
scope or quality? How much is the total cost now?

Please answer the following questions:

1.	 The cost should now be $104,410.00, down from $138,210.00. If you found 
a different answer, compare it with the solution file 09 Opt-TimeCost3.mpp. 
Make sure you insert column Cost before comparing.

2.	 What is the forecasted duration for the project now? 

3.	 Are there trade-offs in the scope or quality? What are they? Will you keep 
the proposed changes? Why?

In this exercise, you’ll use the optimizing for time, cost and resources approach 
and level the workloads manually. Open the file 09 Opt-TimeCostResources1.mpp.

1.	 Determine the period basis that identifies over-allocations by hours, 
days, weeks, or months. (Use the Leveling Options feature to determine 
the calculations basis of day by day, week by week, etc. Be sure to keep the 
Manual leveling calculation selected and avoid any leveling—just accept 
the settings) 

2.	 Which view do you recommend for checking the over-allocations? (You 
could use Resource Sheet, Resource Graph, Team Planner, Resource 
Allocation, and others.)

Relocation 
Project — Solve 
Over-allocations 
by Assigning 
Available 
Resources 
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3.	 In a day by day basis, you find that Nancy Hilcrest and yourself are over-
allocated. Try to solve the over-allocations by finding other resources who 
are available and can perform the work.

4.	 Using the Team Planner view, assign the tasks with over-allocation 
problems to other resources. You can reassign Visit the Sites task (assigned 
to Nancy Hilcrest) to Nelson Salin, and Select the Contractor task (assigned to 
You) to Nelson Salin as well.

5.	 Compare your file with the solution file 09 Opt-TimeCostResources2.mpp. 

In this exercise you’ll try the optimizing for time, cost and resources approach 
and level the workloads automatically. Open the file 09 Opt-TimeCostResources3.
mpp.

What is the current duration of the project?

1.	 Use resource leveling to resolve all the over-allocations. Which view do you 
recommend for analyzing the results of workload leveling? Which field does 
Project 2013 change when leveling? Which tasks were delayed? By how 
much? (You can use the Leveling Gantt, Resource Allocation, and others.) 

2.	 Has Project 2013 increased the duration of the project? Why? 

3.	 Are there any trade-offs in scope or quality? Would you keep the solution 
proposed by Project 2013? Why?

4.	 Compare your file with the solution file 09 Opt-TimeCostResources4.mpp. 
Use the Leveling Gantt view or make sure you insert the column Leveling 
Delay before comparing.

In this exercise, you will use the optimizing for time, cost, and resources 
approach using the Resource-Critical Path (RCP). Open the file 09 Opt-
TimeCostResources5-Intranet.mpp.8

1.	 How many resources do you need by month?

2.	 Would you level this schedule manually? Why?

3.	 What is the current duration of the project?

4.	 Level the workloads automatically. What is the duration now?

5.	 Check the critical path in the schedule. Does it make sense?

6.	 Mark the RCP by entering Yes in the field Marked for each resource-critical 
task.

8	 We will use a different project here with a different scenario; in the previous exercise workload leveling 
did not affect the project end date. In other words, the critical path was identical to the Resource-Critical 
Path.

Relocation Project 
— Solve Over-
allocation Using 
Resource Leveling 

Intranet Project 
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7.	 In the Gantt Chart view, on the Format tab, Bar Styles group, uncheck 
the Critical Tasks checkbox, choose Format, Bar Styles, and change the 
settings to show a blue bar for all Normal tasks (critical and noncritical) and 
a red task bar for all Normal, Marked tasks. You should now see red task 
bars for all tasks on the RCP in the schedule.

8.	 Compare your file 09 Opt-TimeCostResources6-Intranet.mpp; the files should 
look the same. 

9.	 The objective now is to bring down the duration of the project as much 
as possible (time), while maintaining or lowering the cost and keeping the 
workload reasonable (resources). Bring down the duration by shortening 
the RCP. Log each change and the resulting total duration of the project for 
each change you decide to keep. Make a few changes before you find the 
new RCP.  

10.	 Compare your results against the ideas that we will discuss in the next 
exercise.

In this exercise, you’ll use the Optimizing for Time, Cost, and Resources 
approach using the Resource-Critical Path (RCP).

Open the file 09 Opt-TimeCostResources6-Intranet.mpp.

What is the current duration and cost of this project schedule?

The challenge is to find methods to decrease the duration of the project that 
don’t increase cost and don’t cause new work overloads. You have to focus on the 
resource-critical tasks on the RCP. The following changes are examples of such 
measures. Enter these changes into the schedule:

1.	 We should be able to take the project manager off the RCP. In general, a 
project manager should never be on the critical path, except perhaps in very 
small projects where he does tasks as a resource as well. 

`` Remove the dependency between task 9 Define specific functionality and 
task 10 Develop project plan. 

`` Give the task 10 Develop project plan a new predecessor: task 3 Define 
user requirements. 

`` Give task 9 Define specific functionality a new successor: task 11 System 
designed. 

`` Level the workloads again. Determine the new RCP. What are the 
duration and cost of the project now? Is task 10 still resource-critical? 
Are there new work overloads?

2.	 On task 50 Communicate roll out plan to users, notice that the Roll-out 
manager is working only 50%. Increase this to 100% while keeping the work 

Intranet Project 
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on the task the same. Level the workloads in the schedule again. What is the 
duration and cost of the project now?

3.	 You see that the longest resource-critical tasks are tasks 36 Develop web pages 
and 37 Develop any custom functionality. They take 20 days in the current 
schedule. If you can find an extra web designer for task 37 Develop any 
custom functionality, you can schedule those two tasks in parallel. You ask 
the resource manager for an extra designer and you get one for that one task. 

`` Create a new resource Web Designer 2, with the same rate as the first 
designer and replace Web Designer with Web Designer 2 to task 37 
Develop any custom functionality. 

`` Set a new dependency between task 35 Determine development tool and 
37 Develop any custom functionality. 

`` Are there new work overloads? Level the workloads again. Determine 
the new RCP. What are the duration and cost of the project now? Are 
tasks 36 and 37 still resource-critical?

Please answer the following questions:

1.	 We started with a schedule of 70 days that was not leveled. We leveled and 
ended up with 114 days. We shortened the schedule to 90 days without 
increasing the cost and without (new) work overloads. Does the current 
RCP make sense? Why?

2.	 Compare your file with the solution file 09 Opt-TimeCostResources7-Intranet.
mpp. 

The client is the IT department of a large multinational company. Recently, 
the organization made the corporate decision to switch from using Project 
Workbench to using Project 2013 for all of its projects. The project managers 
still work very much as they did when they used Project Workbench; they like to 
enter actual hours worked and remaining hours. The organization has a separate 
time sheet system that reports actual hours worked by project or by category 
over many projects (e.g., “maintenance”).

Managers in the IT department are using the Project 2013 schedules as 
checklists. Many of them become frustrated using the scheduling features of 
Project 2013 and revert to using Excel instead. When this was acknowledged, 
the client decided to organize basic training in Project 2013 using a local training 
provider. Since the training, one year ago, the situation has not improved much, 
and many people are still using Excel. The ones who use Project 2013 are not 
taking advantage of all the features of the application.

In interviews with several users you find that they experience the following 
problems:

Case Study — 
Multinational IT
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hh Double data entry of actual hours into the time sheet system and into the 
project scheduler.

hh IT executives impose tight deadlines and use cost-payback arguments to 
successfully defend these challenging project deadlines. Your clients, the IT 
project managers, tell you, “We have not been able to prove that these deadlines 
are not feasible.”

hh The organization has a matrix structure; many resources are working part-
time on the project and are shared across several projects. There are many 
over-allocations, so many in fact that the project managers were advised by 
Project Workbench consultants to use Auto Schedule (automatic workload 
leveling), after which they should try to shorten the schedule.

hh The organization experiences ripple effects between projects; a change in 
one project can have impacts on other schedules.

hh Most projects are independent and do not have cross-project dependencies.
hh The training did not teach participants how to apply Project 2013 to their 

own real life projects.

There is a need for more guidance so that project managers begin using the more 
beneficial features of Project 2013.

Questions

1.	 Which feature of Project 2013 should be used to address the ripple effect 
across projects?

2.	 What optimization method do you recommend in this situation? Why?

3.	 Will they be able to prove that the imposed deadlines are not feasible?

4.	 What would you recommend in order to:
`` Get more project managers to use Project 2013?
`` Get project managers to use more features of Project 2013?

1.	 Open the file 09 Sure Critical.mpp.

Why are only tasks 3, 4, 5, and 6 shown as critical and not tasks 1 and 2?

2.	 Open the file 09 Why Overload.mpp.

Why is the resource “You” over-allocated in the week of August 24th; this 
resource is only showing 40 hrs of work for the entire week?

Troubleshooting
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Objective:
Update the project tasks and try out options for optimizing the entire 
project.

Project 2013 Objectives: 
1.	 Update Tasks.
2.	 Optimize for Time and Cost.

Exercise Deliverables:
Project 2013 file with updated status and optimizations.

Open the file 10 Updating the Schedule 1.mpp.

1.	 Change to the Tracking Gantt view and Tracking table, hide the Physical 
% Complete field. 

2.	 Set the baseline for the entire project.

3.	 Set the Status Date and the Current Date to September 19, 2014 and create 
a gridline for the status date in the Gantt timescale. (Line to Change: Status 
Date, Type: Continuous Line, Color: Red)

4.	 Set the following options in File tab, Options, Schedule:
`` Check Updating Task status updates resource status
`` Check Actual costs are always calculated by Project

5.	 Switch the task Type to Fixed Units and non Effort-Driven for all tasks.

6.	 Enter the status of the project by updating the tasks. As of September 19, 
2014 the situation is: All the tasks until Remodeled Location are done and 
ran as scheduled. (This update includes the Select Mover task.)

7.	 The contractor started late, because he finished his previous contract late. 
He supplied the following update:

Task Started
Actual  
Duration

Remaining  
Duration

relocate walls 15 Sept. 2d 15 d

8.	 The rest of the tasks have not started yet. Check whether the remaining 
durations are scheduled before the status date. Reschedule these after the 
status date. Also check if there are actual durations after the status date and 
reschedule these before the status date.

9.	 Describe the status of the project in your own words.

10.	 Compare your file with the solution file 10 Updating the Schedule 2.mpp. 

Chapter 10: Updating the Schedule
Chapter 
Objectives

Relocation Project 
– Updating Tasks
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Open the file 10 Updating the Schedule 2.mpp.

1.	 You find this schedule too risky; you need to meet the new deadline date of 
November 14, 2014 and on top of that, you need a time buffer to meet the 
project deadline. You decide to explore whether working overtime offers 
solutions. The overtime rates are:

Name Std. Rate Overtime Rate
The employees $ 25/h $ 50/h

The contractor $ 30/h $ 50/h

The LAN consultants $ 75/h $ 100/h

The Realtor $ 35/h $ 45/h

2.	 What is the cost of the project now?

3.	 Which people would you ask to work overtime first in order to meet the 
November 14th deadline? Why?

4.	 You want to explore whether overtime by the contractor can solve the 
schedule conflict. How many overtime person days do you propose on 
which tasks to meet the deadline?

5.	 How much does your project cost if you pay the overtime rates?

6.	 Could you negotiate to pay regular rates instead?

7.	 How would you enter the overtime work if you pay the regular standard 
rate?

8.	 Are you able to apply fast track to any tasks? Which ones?

9.	 Compare your file with the solution file 10 Updating the Schedule 3.mpp.

Relocation Project 
– Optimizing for 
Time and Cost 
Again
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Objective:

Demonstrate the ease of Project 2013 to generate reports addressed to the 
different levels over the organization to fulfill different purposes and needs 
of the project.

Project 2013 Objectives: 
1.	 Prepare Visual Reports.
2.	 Prepare an Executive Overview.
3.	 Report on Cost by Function.
4.	 Print the Gantt Chart.

Exercise Deliverables:
Various report and print views in Project 2013 and Excel.

This exercise will  introduce you to a type of Visual Report. If you would like 
additional practice creating visual reports we suggest that you locate a text on 
Microsoft Office Excel or Pivot Tables.

Open the file 11 Reporting 1.mpp.

1.	 In the Visual Reports – Create Report dialog box, select the Excel Report…
Resource Remaining Work Report.

2.	 We want to see the custom fields of the resources (Position and Function). 
Click Edit Template, under Select Custom Fields, Add Position and 
Function to Selected Custom Fields, and click Edit Template.

3.	 Set level of usage data to include to Weeks and click on the View button. A 
report will be created in Microsoft Excel.

4.	 What is the status on the remaining work of the resources? There are different 
options to show the information in this kind of reports. In this case, instead 
of seeing the actual work and remaining work and its sum, the stakeholders 
want to review the relative work executed in the project. Follow the next 
steps to modify the report:

`` On Excel, on the Design tab, Type group, click Change Chart type, 
and select Bar, 100% Stacked Bar (the 3rd from left-right).

`` On the Pivot Table Field List panel, uncheck Remaining Work, and 
check Work.

5.	 In the same report, we need to include the table with the detailed information 
of the work in case the stakeholders need more detail, they will be able to 
see it. In addition, we want to show the custom field information of each 
resource that is treated as a Property Field.

Chapter 11: Reporting
Chapter 
Objectives

Relocation 
Project — Visual 
Reports	
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`` At the bottom change to the Resource Summary worksheet by 
clicking on it.

`` In the Pivot Table, over the Resources list, right click and select Show 
Properties in Report, and click Function. Repeat the same to show 
Position.

6.	 Compare your file with the  solution file 11 ResourceRemainingWorkReport_
Sol.xlsx.

Open the file 11 Reporting 1.mpp. We will create three similar custom reports 
that provide executives with a high-level overview of the project.

1.	 Tracking Gantt with Milestones:

`` In the Tracking Gantt view, create a new task table named Executive 
Overview and apply it. Use the columns ID, Name, Duration and Cost.

`` Create a new filter, Executive Overview, to display milestones and their 
summary tasks and apply it.

`` Save the view as Executive Overview. Make sure that when you apply 
the view Executive Overview, the corresponding table and filter are both 
applied.

`` Hide the question marks in the duration column by choosing File Tab, 
Options, on Schedule, clear the option Show that scheduled tasks 
have estimated duration.

`` Apply the following formatting on the timescale: View tab, Zoom 
group, Timescale dropdown list, Timescale…:

Timescale 
Settings

Middle Tier Bottom Tier

Units Months Week

Label Jan ’09 W1, W2, W3,..(From Start)

Count 1 1

Align Center Center

Size 95% 95%

`` Format the Header, Footer, and Legend of the Gantt Chart in the 
Page Setup as follows:

Relocation Project 
— Reporting 
an Executive 
Overview
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Page 
Tab Section Set to Font
Page Scaling Fit to: 1 pages wide by 1 tall

Header Center &[View] &[Project Title] Segoe UI, Bold, 20

Footer
Left &[Manager]

&[Company]
Segoe UI, Regular, 8

Right &[Date] Segoe UI, Regular, 8

Legend Legend on None

2.	 Timeline view:

`` Select all the deliverables and milestones and click Add to Timeline 
(Task tab, Properties group)

`` On the Timeline view, Zoom out/in so all the timeline appears 
complete.

`` On the Format tab, Show/Hide group, apply the following fixes:
▶▶ Date format: Jan’28
▶▶ Text Lines: 2

`` Format the Header, Footer, and Legend of the Timeline in the Page 
Setup as follows:

Page 
Tab Section Set to Font
Page Scaling Fit to: 1 pages wide by 1 tall

Header Center &[View] &[Project Title] Segoe UI, Bold, 20

Footer
Left &[Manager]

&[Company]
Segoe UI, Regular, 8

Right &[Date] Segoe UI, Regular, 8

`` Save the Timeline view with the name Executive Overview Timeline.

3.	 Milestones Report:

`` The Milestones report may not meet the requirements for a Dynamic 
Scheduling approach so we need to tweak some settings. We will create 
two filters, Executive Past Due Milestones and Executive UP NEXT 
milestones.

`` Create the Executive Past Due Milestones filter:
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And/Or Field Name Test Value(s)
Active Equals Yes

And Milestone Equals Yes

And % Complete Equals 100%

And Start Is greater than [Baseline Start]

Or

Active Equals Yes

And Milestone Equals

And % Complete Equals 100%

And Deadline Is less than [Start]

`` Create the Executive UP NEXT Milestones filter:

And/Or Field Name Test Value(s)
Active Equals Yes

And Milestone Equals Yes

And % Complete Does not Equal 100%

`` Go to Report tab, View Reports group, In Progress downward 
button, click Milestone Report. 

`` Click on the empty table of LATE MILESTONES, and in the Field 
List panel, change the Filter to Executive Past Due Milestones.

`` Click on the empty table of MILESTONES UP NEXT, and in the Field 
List panel, change the Filter to Executive UP NEXT Milestones.

`` Click on the Remaining tasks graph, and in the Field List panel, under 
Select Category, click Edit.  Update the information with the following 
information:

Units: Weeks

Date Format: Jan 25, Feb1, …

Count: 1

Start: Aug 4 ‘14

Finish: Dec 1’14

`` On the Design tab, Page Setup group, click Page Breaks. 
Reaccommodate the graphic elements so all the components fit in one 
page.
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`` Format the Header, Footer, and Legend of the Gantt Chart in the 
Page Setup as follows:

Page 
Tab Section Set to Font
Header Center &[View] &[Project Title] Segoe UI, Bold, 20

Footer
Left &[Manager]

&[Company]
Segoe UI, Regular, 8

Right &[Date] Segoe UI, Regular, 8

`` Rename your report with the name Executive Overview Report.

4.	 You now have three different reports you can use for executive level. Which 
one is better? Why?

5.	 Compare your file with the views Executive Overview, Executive Overview 
Timeline, and Executive Overview Report in the solution file 11 Reporting 
2.mpp. 

Open the file 11 Reporting 2.mpp.

1.	 Switch to the Resource Sheet view.

2.	 Create and apply a new resource table Cost by Function that shows the fields 
ID, Name, Position, Function, and Cost. Remember that the Position and 
Function fields corresponds to Text 1 and Text 2 field.

3.	 Create and apply a grouping Cost by Function so that you can easily read the 
total cost by function category of the project.

4.	 Save the view with the name Cost by Function. The view should apply the 
corresponding table and grouping.

5.	 Set the Page Setup settings to the following:

Tab Section Set to
Page Orientation Portrait

Scaling Fit to: 1 page wide by 1 tall

Margins top, bottom, left, right 0.7 inch or 1.8 cm

Borders Around every page

Header Center
Segoe UI, Bold, 16

&[View] &[Project Title] 

Footer Left &[Manager] &[Company]

Center none; delete the default entry

Right &[Date]

Relocation Project 
— Reporting Cost 
by Function



42

Dynamic Scheduling® with Microsoft® Project 2013

6.	 Compare your file with the solution file 11 Reporting 3.mpp.

With the tasks, estimates, dependencies, and constraints completed, we now 
have entered all the data needed to print a Gantt Chart. Open the file 11 
Reporting 1.mpp.

1.	 Format the timescale of the Gantt Chart in the following way:

Middle Tier Bottom Tier
Units Months Week

Label Jan ’09 W1, W2, W3,..(From 
Start)

Count 1 1

Align Center Center

Size 95 % 95%

2.	 Format the header, footer, and legend of the Gantt Chart in the following 
way:

Page Tab Section Set to Font
Header Center &[View] &[Project Title] Segoe UI, Bold, 16

Footer
Left &[Manager]  

&[Company]
Segoe UI, Regular, 8

Right &[Date] Segoe UI, Regular, 8

Legend Legend on None

3.	 Do a print preview to see the report.

4.	 Compare your file with (a printout of) the solution file 11 Reporting 4.mpp.

Relocation Project 
— Printing the 
Gantt Chart
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Objective:
Demonstrate Earned Value relevance over the entire project.

Project 2013 Objectives: 
1.	 Update the progress of tasks.
2.	 Apply Earned Value Management (EVM).
3.	 Analyze the performance of the project based on EVM methodology.

Exercise Deliverables:
Earned Value Visual Report in Project 2013 and Excel 2013.

Open the file 12 EVM 1.mpp.

1.	 Set the current view so you are able to see the Tracking Gantt View, the 
Earned Value table.

2.	 On the View tab, Data group, click Outline, and select Level 1.

3.	 What is the overall status of the Relocation Project? 

4.	 How would you describe the performance of the Remodeled Location 
deliverable according to this report? 

5.	 Take a look at the Earned Value Visual Report for this Project. It is an 
Excel Chart and Table called Earned Value Over Time. Does this reflect 
your conclusions from the previous EVM analysis you did with the Earned 
Value Table? Does the Earned Value Over Time Visual Report add any new 
information?

6.	 Take a look at the Earned Value Report. Report tab, View Reports group, 
click Costs button and select Earned Value Report. Does this reflect your 
conclusions from the previous EVM analysis you did with the Earned Value 
Table? Do you need to change something?

7.	 Update the Project considering the following data:
`` Status date: Oct 3 ’14. 
`` Task 19 Relocate Walls has run as scheduled (Task tab, Schedule, Mark 

on Track)

8.	 Now, what is the overall status of the Relocation Project and what is the 
performance of the Remodeled Location deliverable?

9.	 Compare your file with the solution file 12 EVM 2.mpp.

Chapter 12: Earned Value Management
Chapter 
Objectives

Relocation Project 
— Earned Value 
Management
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Open the file 12 EVM 2.mpp.

1.	 Switch to table Earned Value Schedule Indicators.

2.	 Open details of the deliverable Remodeled Location. What tasks have 
trouble? Why?

3.	 Go to the Resource Sheet and review the Accrue at definition for the 
contractor personnel. Is it recommendable to Accrue at the End ? Why yes 
or why not?

4.	 Do you think that subdividing the task into more detailed elements would 
help to prevent having such big deviations from one week to another?

Troubleshooting
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Objective:
Analyze your experience on a completed project in terms of the 
accomplishment of the objectives and benefits that were defined when the 
project was approved. 

Project 2013 Objectives: 
1.	 Compare baselines.
2.	 Use the Compare Projects feature.
3.	 Create templates for future projects.

Exercise Deliverables:
Compared projects in Project 2013
Template in Project 2013

After analyzing the impact in the performance of the contractor in task 19 
Relocate walls, you applied some optimization techniques and came up with a 
new solution that allows you to open the location before November 14, the last 
approved delivery date and within budget with an estimated total of $139,210. 
Since the changes returned a very different schedule, a new baseline was 
authorized for all tasks except 19 Relocate Walls. 

Open the file 13 Evaluating 1.mpp.

1.	 Go to the Tracking Gantt view and Tracking table. You can now compare 
the actual information against the active baseline.

2.	 In this schedule baselines 1 and 2 had already been defined, so go to the 
Multiple Baselines Gantt view to compare the different baselines in order 
to evaluate the performance of your project.

Keep the 13 Evaluating 2.mpp file open. Also open the file 13 Evaluating 3.mpp, 
that is a previous version of the schedule.

1.	 From 13 Evaluating 2.mpp file, go to Reports tab, Project group, and click 
Compare Projects. Choose 13 Evaluating 3 file and select Entry, for Task 
Table.

2.	 Take a look to the available windows and analyze the differences between 
the two files for each field to answer the following questions. Hint, you can 
use the autofilter and the Compare Projects tab to navigate.
`` Are there new tasks?
`` What tasks changed durations?
`` What tasks changed Costs?
`` What tasks changed in Work?
`` Are there new resources?

Chapter 13: Evaluating the Project
Chapter 
Objectives

Compare 
Baselines

Compare Projects
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3.	 Save the Comparison Report as Relocation Analysis.mpp.

4.	 Compare your file with the solution file 13 Evaluating 3.mpp.

Open the file 13 Evaluating Template 1.mpp.

1.	 On the Format tab, Drawings group, Drawing drop down list, select Text 
box. 

2.	 Put the text box over the chart area and type: This is a Template.

3.	 Save the file as template, select all fields under Select for type of data to 
remove from the template except Resource Rates, and name it Relocation 
Template, so the file will be: Relocation Template.mpt.

4.	 Compare your file with the solution file 13 Evaluating Template 2.mpt.

Create Templates
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Objective:
Manage consolidated schedules with Project 2013. 

Project 2013 Objectives: 
1.	 Create a central resource pool from scratch or from an existing schedule.
2.	 Insert subprojects into a consolidated schedule.
3.	 Explain what a cross-project link is and why it is used.
4.	 Level resources across projects.
5.	 Baseline a consolidated schedule.

Exercise Deliverables:
Resource pool in Project 2013
Consolidated Schedule in Project 2013

You are the manager for a major event and have to organize the tasks and resource 
assignments.

Open the A1 Consolidated Schedule Resources01.mpp file (blank project). 

1.	 Go to the Resource sheet view and type the following data:

Resource Name Type Std. Rate
Alejandro Acevedo

Work

$75.00/hr
Francisco Ambriz $50.00/hr
Julio Díaz $70.00/hr
Mario Landa $30.00/hr
You (type your name) $110.00/hr

2.	 Save your file and keep it opened.

You have identified the preliminary tasks of the event and now need to assign 
resources from the pool. In the Gantt Chart view type the following:

WBS Task Duration Predecessor Resource 
Names

1 SHIPPING 
EVENT 
MATERIALS

1.1 Ship materials 01 d Alejandro Acevedo
1.2 Ship any necessary 

supporting 
equipment

02 d 1.1 Francisco Ambriz

2 Manage day of Event 05 d
3 Market Event 

Success
02 d

4 Event Complete 0d

Appendix 1: Consolidated Schedules
Chapter 
Objectives

Case Study 
Information:
Resource Pool
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You realize that the tasks Manage Day of Event and Market Event Success require 
activities like manage vendors and speakers, select sites, and prepare contracts, 
etc., so you decide to turn both tasks into subprojects. Now you have a Program 
to manage.

As a program manager, you assign the project managers and tell them to use your 
resource list as a pool so they have to create their plans using your file.

Now you need to act as the project managers for the subprojects A1 Event_
Manage.mpp and A1 Marketing Event Success.mpp. Each file has a scheduled plan 
without the resources assigned. You are going to use the A1 Event_Consolidated.
mpp file resources, using the Resource Pool feature. 

1.	 Open the file A1 Event_Manage.mpp files.

2.	 In the Resource tab, Assignments group, click Resource Pool, and select 
Share Resources. Set the options to use the resources from A1 Event_
Consolidated.mpp. 

3.	 Make the following assignments:

Task Name Resource Name
Review equipment Alejandro Acevedo
Manage setup Francisco Ambriz
Manage registration Julio Diaz
Manage vendors Mario Landa
Manage speakers Alejandro Acevedo
Manage teardown Francisco Ambriz
Route leads to sales Mario Landa

4.	 Set the project baseline.

5.	 Open the file A1 Event_Marketing.mpp files.

6.	 In the Resource tab, Assignments group, click Resource Pool, and select 
Share Resources. Set the options to use the resources from A1 Event_
Consolidated.mpp. 

7.	 Make the following assignments:

Task Name Resource Name
Finalize contracts Alejandro Acevedo, Francisco 

Ambriz, Julio Diaz
Event debrief with speakers Alejandro Acevedo, Francisco 

Ambriz, Julio Diaz, Mario 
Landa

Event debrief with event 
team

Julio Diaz

8.	 Set the project baseline.
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1.	 In the A1 Event_Consolidated.mpp file, substitute task Manage Day of Event 
with the inserted subproject A1 Event_Manage, and 

2.	 Substitute task Market Event Success with the inserted subproject A1 Event_
Marketing.

3.	 Move to the Tracking Gantt view.

1.	 In the A1 Event_Consolidated.mpp file, expand the details of the inserted 
projects. 

2.	 Link the following tasks across projects:

Task To Task Type
Ship any necessary 
supporting equipment

Review equipment FS

Manage vendors Finalize contracts FS
Day of Event Complete Event Complete FS
Complete Event Complete FS

3.	 Notice that some over-allocations exist.

1.	 Continue to work in the A1 Event_Consolidated.mpp file.

2.	 On the Resource tab, Level group, select Level Resource feature for all the 
resources assigned. Note that there are no more over-allocations, but your 
finish date has changed and task Manage Speakers has been delayed.

3.	 Insert the Priority column.

4.	 For task Manage Day of Event, change the priority to 600 and click Level 
All again. Now the task Finalize contracts is delayed.

5.	 Compare your file with the A1 EventSol_Consolidated file.

1.	 Set the baseline for your entire program file. Hint, you must select all the 
tasks in the master project to save the baseline of both the master project 
and the subprojects.

2.	 Save the master project and the subprojects.

Consolidated 
Schedule

Cross-Project 
Links

Level Resources 
Across Projects

Baseline a 
Consolidated 
Schedule
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